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Using RND

This document contains reference information and step-by-step procedures designed to assist you as you use 
Gentran:Server® for Windows® to work with Rede Nacional de Dados (RND), a Brazilian automotive 
standard, to exchange business documents.

The RND standard files are not included in the Gentran Standards Database. Instead, Sterling Commerce 
provides RND support for Gentran:Server for Windows by providing files on the Gentran Standards Disc.

You must complete the following to use RND:

1. Completing Prerequisites on page 8
2. Installing RND Standard Files to your Hard Drive on page 9
3. Implementing RND with Gentran:Server for Windows on page 9
Note: You cannot process an RND map until you have completed the preliminary configuration steps.

RND Standard folder Files and Contents
Because the RND standard is not included in the Gentran Standards Database, the Gentran Standards Disc 
contains standards files that enable you to use RND with Gentran:Server for Windows. The tutorial files 
available on the disc enable you to quickly see how to implement RND. These files are located in the 
GENSRVNT\RND Standard folder on your hard drive.

✦ IFD Files or Standard Layouts (IFD Folder) on page 5
✦ System Maps and Translation Objects (SystemMaps Folder) on page 6
✦ Tutorial Files (Tutorial Folder) on page 7

IFD Files or Standard Layouts (IFD Folder)
A standard layout (.IFD file) is a file definition that contains the RND standard layout.

Note: The integrator file definition (.IFD) is a Sterling Commerce format that contains a proprietary binary 
file format description of the input or output side of a source map and has the file extension .IFD. 
The .IFD files include the hierarchical and looping structure of the data, the map objects (groups, 
records, fields) and their attributes (for example, names, descriptions, data types). An .IFD file can 
Sterling Commerce, Inc. 5



RND Standard folder Files and Contents
be loaded (imported) or created (for export) from Application Integration. The .IFD files do not 
contain standard or extended rules, links, or any other map information unrelated to the data, 
although the one exception is the Use Code code lists. If the map references a Use Code standard 
rule and instructs Gentran:Server for Windows to raise a compliance error if the code is not found in 
the Use Code code list, Gentran:Server for Windows saves the standard rule and the associated code 
list.

Sterling Commerce provides an .IFD file for each supported message type.

The GENSRVNT\RND Standard\IFD folder on your hard drive (after you install the RND standards from 
the Gentran Standards Disc) contains .IFD files for the following RND standard layouts.

See Creating an RND Map on page 11 for step-by-step instructions on how to use .IFD files to create maps.

System Maps and Translation Objects (SystemMaps Folder)

System Maps
The following system maps are included within the GENSRVNT\RND Standard folder on your hard drive 
(after you install the RND standards from the Gentran Standards Disc). The maps are located in the 
SystemMaps Folder.

File Name For Business Document Type

RND001.IFD Material/Parts Schedule

RND002.IFD Need Diary Production

RDN003.IFD Parts/Material Criticize

RND004.IFD Material/Parts Ship

RND005.IFD Material/Parts in Delay

RND006.IFD Answer of Delivery PGM

RND007.IFD Purchase Order

RND008.IFD Request of Alteration

RND010.IFD Solicitation of Quotation

RND012.IFD Daily Programming of Piece/Material

Map Name  Description

BrkIrnd.map Interchange break map

BrkTrnd.map Transaction break map

BldIrnd.map Interchange build map

BldTrnd.map Transaction build map
Sterling Commerce, Inc. 6



RND Standard folder Files and Contents
System Translation Objects
The following RND system translation objects (compiled maps) also are included in the GENSRVNT 
\RND Standard\SystemMaps folder.

See Registering System and Tutorial Translation Objects on page 10 for step-by-step instructions on how to 
register the system translation objects.

Tutorial Files (Tutorial Folder)
In the GENSRVNT\RND Standard folder on your hard drive (after you install the RND standards from the 
Gentran Standards Disc), RND tutorial files have been provided (in the Tutorial Folder) to assist you as you 
work with RND Standards These tutorial files enable you to view examples of RND maps, data files, and 
so forth. These files will help you break the inbound and outbound processes and procedures into concise 
and understandable steps, using examples that enable you to understand and master the tasks and processes 
required for you to implement RND at your installation. 

Map Files
The following table describes the RND tutorial maps created for use with Gentran:Server for Windows.
 

Note: Custom maps are available through Sterling Commerce Customer Support.

Text Files
The following table describes the text files provided in the GENSRVNT\RND Standard\Tutorial folder. 
These text files enable you to process the test data through the system.
 

Map Name Description

BrkIrnd.tpl Interchange break map

BrkTrnd.tpl Transaction break map

BldIrnd.tpl Interchange build map

BldTrnd.tpl Transaction build map

Map Name  Business Document Type RND Transaction

RND_Sys_import.map System import header map for
RND001o.map

RND001i.map Export map - Material/Parts 
Schedule

001

RND001o.map Import map - Material/Parts Schedule 001

File Name Description

RND001i.txt Inbound data file for RND001i.map
Sterling Commerce, Inc. 7



Completing Prerequisites
Partner File
The following table describes the trading partner file provided in the GENSRVNT\RND Standard\Tutorial 
folder. This exported partner file enables you to process the test data through the system.
 

See Implementing RND with Gentran:Server for Windows on page 9 for more information on using these 
tutorial files.

Completing Prerequisites 
Before you can successfully use RND with Gentran:Server for Windows, you must complete the following 
criteria and tasks:

✦ Required Software and Software Knowledge on page 8
✦ RND with Gentran:Server for Windows on page 8
✦ Installing RND Standard Files to your Hard Drive on page 9

Required Software and Software Knowledge
To use the RND standard with Gentran:Server for Windows, you must:

✦ Successfully install Gentran:Server for Windows.
✦ Be familiar with Gentran:Server for Windows and the RND standard.
Note: This documentation is not intended to explain the RND standard.
✦ Have access to a Gentran:Server for Windows system administrator while you are implementing RND, 

in case you need assistance with the configuration process.

RND with Gentran:Server for Windows
RND has several features that distinguish it from most other EDI standards, including the following:

Note: Please review this section prior to implementing RND with Gentran:Server.
✦ It does not use functional groups.
✦ It uses a positional, non-delimited format.
✦ It uses looping elements but not composite elements.
✦ In some messages, it processes date formats differently.

RND001o.txt Outbound data file for RND001o.map

File Used With

RNDTEST.par RND001i.map and RND001o.map
Sterling Commerce, Inc. 8



Implementing RND with Gentran:Server for Windows
✦ It uses a separate message to identify the communications protocol. Each RND message is defined by 
a three-digit number, which appears in the data.

✦ Each record begins with a three-byte record ID and a two-byte version number.

Installing RND Standard Files to your Hard Drive
To use the RND standard with Gentran:Server for Windows, you must install the standards files from the 
Gentran Standards Disc to your hard drive (if you have installed Gentran:Server in a clustered environment, 
you must install the RND standard files on every client machine on which Application Integration is 
installed). Before you begin installing the RND files, ensure that you have installed Gentran:Server for 
Windows.

Use this procedure to install the RND standards files onto your hard drive:

1. Insert the Gentran Standards Disc containing the RND tutorial data, partner file, maps, translation 
objects, and integrator file definition (.IFD) files into the appropriate drive on your machine.

2. Start Windows Explorer and browse to the drive where you inserted the Gentran Standards Disc.
3. Navigate to the Rnd \Windows folder and double-click Setup.exe. Windows launches the installation 

program.

4. Click Next to display the Choose Destination Location dialog box.
5. Click Next to accept the default installation location.
Note: We recommend accept the default to install the RND files under the standard Gentran:Server for 

Windows installation folder on your hard drive (GENSRVNT).
6. Click OK to complete the installation procedure.

Implementing RND with Gentran:Server for Windows
Before you can set up or test RND with Gentran:Server for Windows, we recommend you complete the 
following procedures to familiarize yourself with how RND is implemented with Gentran:Server:

✦ Compiling the Tutorial Maps on page 9
✦ Registering System and Tutorial Translation Objects on page 10
✦ Creating an RND Splitter Entry on page 11
✦ Creating an RND Map on page 11
✦ Creating an RND Trading Partner on page 13

Compiling the Tutorial Maps
The Compile function compiles the map and creates a translation object. You use the Compile function after 
the map is completed and saved. The map that you create using Gentran:Server for Windows is a source 
map (the .MAP file). When that source map is compiled, the result is a compiled translation object (a .TPL 
Sterling Commerce, Inc. 9



Implementing RND with Gentran:Server for Windows
file). This translation object must be registered with the Gentran:Server for Windows system before you can 
use it.

Use this procedure to compile the RND tutorial maps and generate translation objects:

1. From the Application Integration File menu, select Open.
2. Browse to the GENSRVNT\RND Standard\tutorial folder on your hard drive and select the 

RND001i.map file.
3. From the Application Integration File menu, select Compile to display the Run-Time Translation 

Object Name dialog box. You are prompted to name the translation object the same name as the map 
file with the file extension .TPL. For example, if the name of the map file is RND001i.map, you are 
prompted with the translation object name RND001i.tpl. Click Save to accept the name and compile 
the map and generate the translation object. The system displays the Compile Errors dialog box.

Note: Name the translation object (.TPL file) the same file name as the map (.MAP file). Preserving the 
same file name (with different file extensions) will ensure that the relationship between the source 
map and the compiled translation object remains evident.

4. Verify that no errors occurred and click OK to exit the Compile Errors dialog box. The date on which 
the translation object was compiled is automatically loaded into the Compiled on box on the 
Translation Object Details dialog box.

5. From the Application Integration File menu, select Save to save the source map with the Compiled 
on date.

6. Complete steps 1 through 6 for each of the following tutorial maps:

RND001o.map

RND_Sys_import.map

Registering System and Tutorial Translation Objects
You need to register the provided RND translation objects in Gentran:Server for Windows before you can 
use them. Use this procedure to register the necessary translation objects:

1. From the Gentran:Server for Windows View menu, select Translation Objects to display the EDI 
Translation Objects browser. 

2. Click New to display the Register Translation Object dialog box. 
3. Browse to the GENSRVNT\RND Standard\SystemMaps folder on your hard drive and select the 

following system translation objects: 

BrkIrnd.tpl

BrkTrnd.tpl

BldIrnd.tpl

BldTrnd.tpl

Note: Press CTRL and click the translation objects to select all the files at once.
4. Click Open to register the translation objects. 
5. Click New to display the Register Translation Object dialog box. 
Sterling Commerce, Inc. 10



Implementing RND with Gentran:Server for Windows
6. Browse to the GENSRVNT\RND Standard\Tutorial folder on your hard drive and select the following 
tutorial translation objects: 

RND001i.tpl

RND001o.tpl

RND_Sys_import.tpl

Note: Press CTRL and click the translation objects to select all the files at once.
7. Click Open to register the translation objects.

Creating an RND Splitter Entry
Use this procedure to create a splitter entry in Gentran:Server for Windows System Configuration to 
implement the RND standard with Gentran:Server for Windows.

1. From your Windows Start menu, select Programs > Gentran Server > Gentran Server 
Configuration to access the System Configuration dialog box. 

2. Select Splitter. 
3. Click New to define the RND splitter entry. 
4. From the Type list, select Positional. 
5. In the Start box, type ITP. 
6. In the End box, type FTP. 
7. In the Interchange Break list, select RND Interchange Break Template. 
8. In the Functional Group Break list, verify that <none> is selected. 
9. In the Transaction Set Break list, select RND Transaction Break Template. 
10. In the Max length of end segment box, type 130. 
11. Click Apply to add the splitter entry. 
12. Click OK to exit the System Configuration dialog box.

Creating an RND Map
Typically, when you are exchanging information with an RND trading partner, you exchange information 
both inbound and outbound. Therefore, you will likely need to create both an inbound map and an out-
bound map.
When you create a new RND map, you will import the appropriate IFD file from the GENSRVNT\RND 
Standard\Tutorial folder to create the RND side of the map. See the Application Integration User’s Guide 
for more information on using IFD files. Alternatively, you can create the RND side of your map yourself 
within Application Integration.

Creating an Inbound RND Map 
Sterling Commerce, Inc. 11



Implementing RND with Gentran:Server for Windows
To create an inbound RND map, you will use Application Integration to import a IFD file to build the input 
side of the map (the output side consists of your positional application file that you will need to build).

Use this procedure to create an inbound RND map:

1. From the Application Integration File menu, select New.
2. In the New Map wizard, answer the following questions and then click Next.

What kind of map are you creating? Select Export.

What is the name of the map? Type the unique name of the map. The Application Integration adds 
the default .MAP extension.

What is your name? Type your name if it differs from the user name prompted by the New Map 
wizard. 

The New Map wizard displays Input Format fields. You must complete the format of the input side of 
the map. This is the format of the data that is translated by Gentran:Server for Windows.

3. In the Input Format window, select the Create a new data format using this syntax option and select 
Positional from the list.

4. Click Next.
5. In the Output Format window, select the Create a new data format using this syntax option and 

select Positional from the list.
6. Click Next.
7. Click Finish to create the map. The map opens in the Application Integration window.

In the Application Integration, select File > Save to save the map. Do not use spaces or apostrophes in 
the map name. To save a map as a .map file, select File > Save As and then select Source Maps 
(*.map) from the Save as type list.

8. In the Application Integration, right-click the data format icon on the INPUT side of the map and select 
Open File Definition from the shortcut menu. A warning message is displayed.

9. Click Yes to continue.
10. Browse to the GENSRVNT\RND Standard\IFD folder to locate the appropriate IFD file.
11. Click Open to open the selected file into the map.
Note: Now you need to create your application layout on the INPUT side of the map, create any necessary 

links, standard rules, and extended rules, and save and compile the map.
See the Application Integration User’s Guide for more information on performing specific mapping 
tasks.

Creating an Outbound RND Map
To create an outbound RND map, you will use Application Integration to import a IFD file to build the 
output side of the map (the input side consists of your positional application file that you will need to build).

Note: When you create an outbound (import) map, you also need to create a system import header map. A 
system import map is used by the system to find the partner relationship for a document, to determine 
which import map is used to translate the data. The system import map builds the key that the 
Sterling Commerce, Inc. 12



Implementing RND with Gentran:Server for Windows
translator uses to find the partner relationship. The sole function of the system import map is to 
identify the appropriate partner relationship; the system import map does not map any data. 

See the Application Integration User's Guide for more information on creating a system import header 
map.

Use this procedure to create an outbound RND map:

1. From the Application Integration File menu, select New.
2. In the New Map wizard, answer the following questions and then click Next.

What kind of map are you creating? Select Import.
What is the name of the map? Type the unique name of the map. The Application Integration adds 
the default .MAP extension.
What is your name? Type your name if it differs from the user name prompted by the New Map 
wizard. 

The New Map wizard displays Input Format fields. You must complete the format of the input side of 
the map. This is the format of the data that is translated by Gentran:Server for Windows

3. In the Input Format window, select the Create a new data format using this syntax option and select 
Positional from the list.

4. Click Next.
5. In the Output Format window, select the Create a new data format using this syntax option and 

select Positional from the list.
6. Click Next.
7. Click Finish to create the map. The map opens in the Application Integration window.

In the Application Integration, select File > Save to save the map. Do not use spaces or apostrophes in 
the map name. To save a map as a .map file, select File > Save As and then select Source Maps 
(*.map) from the Save as type list.

8. In the Application Integration, right-click the data format icon on the OUTPUT side of the map and 
select Open File Definition from the shortcut menu. A warning message is displayed.

9. Click Yes to continue.
10. Browse to the GENSRVNT\RND Standard\IFD folder to locate the appropriate IFD file.
11. Click Open to open the selected file into the map.
Note: Now you need to create your application layout on the OUTPUT side of the map, create any 

necessary links, standard rules, and extended rules, and save and compile the map. 
See the Application Integration User’s Guide for more information on performing specific mapping 
tasks.

Creating an RND Trading Partner
To create an RND trading partner relationship, you need to create a partner profile.

If you are receiving and processing information from that trading partner, you need to define an appropriate 
inbound relationship that is associated with that partner profile. 
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Implementing RND with Gentran:Server for Windows
If you are sending information to this trading partner, you need to define an outbound relationship that is 
associated with that partner profile. The outbound relationship includes the envelope definition.

Task

You need to create a partner profile and the appropriate inbound and outbound relationships for each partner 
with whom you are going to exchange data.

Note: If you are also using RosettaNet with Gentran:Server (in addition to using RND), contact customer 
support for instructions on creating and managing RND trading partners.

Importing the RND Tutorial Partner Profile
The tutorial partner profile (RNDTEST.par) is a sample RND partner profile. We recommend that you 
import this partner profile and review it prior to creating partner profiles for your own RND trading partners.

Use this procedure to import the tutorial partner profile:

1. From the Gentran:Server for Windows Tools menu, Select Partner Editor to access the Partner 
Editor dialog box. 

2. Click Import to access the Import File Select dialog box. 
3. Browse to the GENSRVNT\RND Standard\Tutorial folder, select the RNDTEST.par profile, and 

click Save to access the Import dialog box. 
4. Verify that the Partner to Import box indicates RNDPART, and click Save. The system imports the 

partner details and displays the Partner Editor dialog boxes. 
Note: Gentran:Server for Windows prompts you for any additional information that is necessary by 

displaying the appropriate Partner Editor dialog box.
5. Click Save when you have typed any necessary information. The system displays the message: Import 

Process Complete. Please note any warnings or errors.
6. Click OK. 

7. Click Exit. 

Creating an Inbound Relationship
1. From the Gentran:Server for Windows Tools menu, select Partner Editor. The system displays the 

Partner Editor dialog Box. 
2. Select the partner profile for which you want to create an inbound relationship and click Inbound. The 

system displays the Inbound Relationship dialog Box.
Note: You must have already created a partner definition for this partner.

Reference
See How to Create a New Partner Definition in the Gentran:Server User’s Guide for more 
information.

3. Click New. The system displays the New Inbound Relationship dialog box. 
4. In the Description box, type a unique relationship name (example, Inbound Invoice) and click Save. 

The system creates a new inbound relationship and returns to the Inbound Relationship dialog box. 
5. From the appropriate lists on the Inbound Relationship dialog box, select the following:
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Implementing RND with Gentran:Server for Windows
Standard (select R for RND)

Version

Transaction Set

Note: The content of these lists are displayed from the translation objects registered in Gentran:Server for 
Windows. For example, if there are no translation objects for RND001 version 06 registered with 
Gentran:Server for Windows, you will not be able to select that version from this dialog box.

The information required for this dialog box should be provided to you by your trading partner when 
this partner defines the details of the transactions they send you. 

6. If you need to define parameters to comply with the processing needs of your partner (example, 
Sequence Checking, Last Used Control, Duplicate Documents, or Generate Acknowledgement), click 
Advanced.

7. To select an inbound translation object, on the Inbound Relationship dialog box, click Translation. 
The system displays the Inbound Translation Object dialog box. 

8. From the lists, select the translation objects that are required for this inbound relationship.
Note: The lists display all the translation objects that are registered in the system that are appropriate for 

the type of translation object (example, Export, Print, and so forth) and the transaction set. If there 
are no translation objects displayed in the lists, no translation objects of that type are registered for 
the version of the document defined in the relationship. 

9. If you selected an Export File translation object and you want to export to a specific file, type the 
universal naming convention (UNC) name of that file in the Export File Name box. 

10. If you want to use the “Export to Mailbox” function to specify a mailbox and e-mail address so the 
output of the inbound translation object can be delivered directly back to the Mailbox Server Manager, 
select the Export to Mailbox check box and complete the appropriate boxes. 

11. Click Save to save your selections and return to the Inbound Relationship dialog box. 
12. On the Inbound Relationship dialog box, verify that <none> is selected for Groups.
13. On the Inbound Relationship dialog box, click Interchanges to display a list of existing 

interchanges. The system displays the Inbound Interchange Select dialog box. 
14. If the required interchange is in the Interchanges list, select the interchange and click Select. 
15. If the required interchange is not in the Interchanges list, on the Inbound Interchange Select dialog 

box, click New. The system displays the Inbound Interchange Entry dialog box. 
16. In the Description box, type the interchange description. 
17. In the Interchange ID box, type the identification of the interchange you are specifying. 
Note: If you have more complex requirements for processing the interchange, click Advanced to display 

the full list of interchange setup options.
18. After you set up the required parameters in this dialog box, click Save to store the information and 

return to the Inbound Interchange Select dialog box. 
19. Highlight the new interchange and click Select to select the interchange and returns to the Inbound 

Relationship dialog box. 
20. On the Inbound Relationship dialog box, click Save to save the inbound relationship. 
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21. Click Exit to return to the Partner Editor dialog box. 

Creating an Outbound Relationship
1. From the Tools menu, select Partner Editor. The system displays the Partner Editor dialog box. 
2. Select the partner profile for which you want to create an outbound relationship and click Outbound. 

The system displays the Outbound Relationship dialog box.
Note: You must have already created a partner definition for this partner.
3. Click New. The system displays the New Outbound Relationship dialog box.
4. In the Description box, type a unique relationship name and click Save. The system creates a new 

outbound relationship and returns to the Outbound Relationship dialog box. 
5. From the appropriate lists on the Outbound Relationship dialog box, select the following:

Standard (Select R for RND)

Version

Transaction Set

Note: The content of these lists are displayed from the translation objects registered in Gentran:Server for 
Windows. For example, if there are no translation objects for RND001 version 06 registered with 
Gentran:Server for Windows, you will not be able to select that version on this dialog box. The 
information required for this dialog box should be provided to you by your trading partner when this 
partner defines the details of the transactions it sends. 

6. If you need to define parameters to comply with the processing needs of your partner (for example, 
Last Used Control Number, Expect Acknowledgement, Hours Overdue, Duplicate Documents, or Test 
Indicator), click Advanced.

7. On the Outbound Relationship dialog box, click Translation to display the Outbound Translation 
Object dialog box. 

8. From the lists, select the translation objects that are required for this outbound relationship.
Note: The lists display all the translation objects that are registered in the system that are appropriate for 

the type of translation object (example, Import, Print, and so forth) and the transaction set. If there 
are no translation objects displayed in the lists, no translation objects of that type are registered for 
the correct version of the document defined in the relationship. 

9. If you selected an Import translation object, you may need to define the following:

In the Application ID box, type the application identifier that indicates the destination for the 
documents.

In the Application Alias Value box, type criteria that the system will use to distinguish this 
relationship from others during the application import function. 

10. Click Save to save your selections and return to the Outbound Relationship dialog box. 
11. On the Outbound Relationship dialog box, verify that <none> is selected for Groups.
12. On the Outbound Relationship dialog box, click Interchanges to display a list of existing 

interchanges.
13. If the required interchange is in the Interchanges list, select the interchange and click Select
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14. If the required interchange is not in the Interchanges list, on the Outbound Interchange Select 
dialog box, click New. The system displays the Outbound Interchange Entry dialog box. 

15. In the Description box, type the interchange description. 
16. In the Interchange ID box, type the identification of the interchange you are specifying. 
Note: The EDI standards define which interchange ID should be used for each type of document. 
17. On the Envelope dialog box, type the appropriate values into the following fields:
Note: RND uses the Generic Interchange Envelope Fields dialog box for the outbound interchange level 

of your partner setup. The list below describes the fields on the Generic Interchange Envelope dialog 
box and indicates the fields to which they correspond in the RND ITP Envelope.

18. In the Segment Terminator hex value box at the bottom of the dialog box, type 0A.
19. Modify any other delimiters necessary.
20. Click Save to save the envelope information.
21. Click Exit to exit the Generic Interchange Envelope Fields dialog box.
22. If you have more complex requirements for processing the interchange, click Advanced on the 

Outbound Interchange Entry dialog box to display the full list of interchange envelope setup options.
Recommendation
Do not change the translation objects in the Interchange Transl. Obj. and Acknowledge Transl. Obj. 
lists, unless you have a specific reason to do so.

23. If you want to use the default Mailbox and e-mail Address, select the appropriate mailbox from the 
Default Mailbox list, or click New Mailbox to create a new mailbox.

Note: See the Communications User’s Guide for more information on creating mailboxes. 
24. Click Save to store the information and return to the Outbound Interchange Entry dialog box. 
25. Click Save to store the information on the Outbound Interchange Entry dialog box and return to the 

Outbound Interchange Select dialog box. 
26. Highlight the new interchange and click Select. 
27. On the Outbound Relationship dialog box, click Save to save the outbound relationship. 
28. Click Exit to return to the Partner Editor dialog box. 

Generic Interchange 
Envelope Fields Dialog 
Box Parameters

Mandatory/Optional Corresponding RND ITP 
Envelope Field

Field Length

Field 1 Mandatory Transmitter IRF code 14

Field 2 Optional Receiver IRF code 14

Field 3 Optional Internal Transmitter code 8

Field 4 Optional Internal Receiver 8

Field 5 Optional Transmitter name 25

Field 6 Optional Receiver name 25
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